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Safety Compliance

Safety Statement
This equipment has been tested to comply with USA and Canadian safety certification in accordance with the specifications of UL Standards: UL60065 7th /IEC 60065 
7th and Canadian CAN/CSA C22.2 60065:03. Avid Inc., has been authorized to apply the appropriate UL & CUL mark on its compliant equipment.

Warning

Important Safety Instructions
1) Read these instructions.

2) Keep these instructions.

3) Heed all warnings.

4) Follow all instructions.

5) Only perform the services explicitly described in the install and or user manual.  For services or procedures not outlined in the install or user manual, speak with 
authorized service personnel.

6) Do not use this equipment near water.

7) Clean only with dry cloth.

8) Do not block any ventilation openings. Install in accordance with the manufacturer’s instructions.

9) Do not install near any heat sources such as radiators, heat registers, stoves, or other equipment (including amplifiers) that produce heat.

10) Do not defeat the safety purpose of the polarized or grounding-type plug. A polarized plug has two blades with one wider than the other. A grounding type plug 
has two blades and a third grounding prong. The wide blade or the third prong are provided for your safety. If the provided plug does not fit into your outlet, consult 
an electrician for replacement of the obsolete outlet.

11) Protect power cords from being walked on or pinched particularly at plugs, convenience receptacles, and the point where they exit from the equipment.

12) Only use attachments/accessories specified by the manufacturer.

13) For products that are not rack-mountable: Use only with a cart, stand, tripod, bracket, or table specified by the manufacturer, or sold with the equipment. When a 
cart is used, use caution when moving the cart/equipment combination to avoid injury from tip-over.

14) Unplug this equipment during lightning storms or when unused for long periods of time. 

15) Refer all servicing to qualified service personnel. Servicing is required when the equipment has been damaged in any way, such as power-supply cord or plug is 
damaged, liquid has been spilled or objects have fallen into the equipment, the equipment has been exposed to rain or moisture, does not operate normally, or has 
been dropped.

16) For products that are a Mains powered device: 
The equipment shall not be exposed to dripping or splashing and no objects filled with liquids (such as vases) shall be placed on the equipment. 

Warning! To reduce the risk of fire or electric shock, do not expose this equipment to rain or moisture. 

17) For products containing a lithium battery: 
CAUTION! Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type. 

18) The power inlet is the main disconnect device and should remain accessible. Disconnect the power cord before servicing the unit.

19) The equipment shall be used at a maximum ambient temperature of 40° C.

20) Disconnect power from mains before opening the product 
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Overview

This guide provides instructions for installing the DNT-192 Dante Option Card in VENUE | Stage 64 I/O racks. The DNT-192 
Dante Option Card for Stage 64 is a 16-channel audio interface card for communicating with Dante networks. Based on the Brook-
lyn II, the DNT-192 can be interfaced directly with any Gigabit Dante devices running compatible firmware. 

Each DNT-192 Dante Option Card occupies two Stage 64 slots. Multiple DNT-192 Dante Option Cards can be installed in adjacent 
input or output slots for maximum input or output from each card. In addition, one DNT-192 card can be installed spanning Stage 
64 input and output slots for “split” input and output from that single card. 

Each Stage 64 supports installation of up to eight input cards (or up to four DNT-192 cards) providing a maximum of 64 input chan-
nels, and up to four output cards (or up to two DNT-192 cards) providing a maximum of 32 output channels. 

DNT-192 Dante Option Card Features and Capabilities

Input and Output
Each DNT-192 card can be installed as an input-only, output-only, or input-and-output interface card. The number of channels of 
input and output vary with sample rate and Stage 64 slot location as shown in the following table. 

Control and Other Capabilities
• Dante controller software is used to configure the cards, monitor health and status, and perform network routing. Dante Con-

troller is available at https://www.audinate.com/products/software/dante-controller.
• The Dante device firmware is field upgradeable, using the Audinate Firmware Update Manager (www.audinate.com).
• Auto-Mute on power up and power down. Outputs can also be manually muted via VENUE software.
• Sample Rate Conversion can be enabled or disabled. SRC supports all Dante sample rates, including pull up and pull down.
• Support multicast and unicast operation, and all other functions and features provided by the Dante card.
• Auto-detection of card presence and I/O (based on slot installation) during Stage 64 initialization.

DNT-192 Dante Option Card IO capabilities and slot requirements, per sample rate

Sample Rate Input Output Stage 64 Slots

48 kHz

16 0 Slots A through H

8 8 Slots H and J only

0 16 Slots J through M

96 kHz

16 0 Slots A through H

8 8 Slots H and J only

0 16 Slots J through M

192 kHz

8 0 Slots A through H

4 4 Slots H and J only

0 8 Slots J through M
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What’s Included
I/O card packages includes the following items:

• I/O card (DNT-192 Dante Option Card)
• Health and Safety guide
• Avid Registration card
• Warranty claims card
• This guide (DNT-192 Dante Option Card Installation guide)

System Requirements and Compatibility
Avid can only assure compatibility and provide support for hardware and software it has tested and approved. DNT-192 Dante 
Option Cards are compatible with Stage 64 I/O racks connected to VENUE | S6L systems running VENUE software 5.2 and higher.

For complete VENUE system requirements and other compatibility information, visit www.avid.com/compatibility.

For information about Dante and Audinate, visit https://www.audinate.com. 

Conventions Used in This Guide
All of our guides use the following conventions to indicate menu choices and key commands:
:

The names of Commands, Options, and Settings that appear on-screen are in a different font.

The following symbols are used to highlight important information:

Convention Action

Options > System In the VENUE software, click Options to display the Options tab, then click 
the System tab.

File > Save Choose Save from the File menu.

Control+N Hold down the Control key and press the N key.

Control-click Hold down the Control key and click the mouse button.

Right-click Click with the right mouse button.

User Tips are helpful hints for getting the most from your system.

Important Notices include information that could affect your data or the performance of your system.

Shortcuts show you useful keyboard or mouse shortcuts.

Cross References point to related sections in this guide and other VENUE guides.
DNT-192 Dante Option Card2



Resources
The Avid website (www.avid.com) is your best online source for information to help you get the most out of your Avid system. 
The following are just a few of the services and features available. 

Account Activation and Product Registration
Activate your product to access downloads in your Avid account (or quickly create an account if you don’t have one). Register your 
purchase online, download software, updates, documentation, and other resources. 

https://www.avid.com/US/account

Support and Downloads
Contact Avid Customer Success (technical support); download software updates and the latest online manuals; browse the Com-
patibility documents for system requirements; search the online Knowledge Base or join the worldwide Avid user community on 
the User Conference. 

https://www.avid.com/products/venue-s6l-system/learn-and-support

For information on the Dante network and other Audinate products: 
https://www.audinate.com

Training and Education
Study on your own using courses available online, find out how you can learn in a classroom setting at an Avid-certified training 
center, or view a webinar. For example, check out the live sound webinars hosted by Robert Scovill: 

http://www.avid.com/live-sound-webinars

Also check out our Live Sound blogs: 
http://www.avidblogs.com/livesound/

Products and Developers
Learn about Avid products; download demo software or learn about our Development Partners and their plug-ins, applications, and 
hardware. 

https://www.avid.com/Products/index.html
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DNT-192 Dante Option Card Hardware Overview

This section provides an overview of the connectors and indicators on the DNT-192 card.

DNT-192 Option Card Front Panel
The DNT-192 Option Card front panel provides the following indicators and connectors. 

SYSTEM LED  Indicates the status of the Dante system on this card.

SYNC LED  Indicates the clock synchronization status of the Dante device.

ERROR LED  Indicates status of the Dante Identify function. 

CONTROL Port  For connection to Windows or Mac computer running Dante Controller, for advanced 
card configuration options, status/monitoring and audio network routing. 

System LED color and indication

Color Indicates

Green All OK, sync achieved

Amber Booting up, awaiting sync

Not lit No power / fault

SYNC LED color and indication

Color Indicates

Green, solid Dante network clock slave, sync achieved

Green, flashing Dante network clock master, sync achieved

Amber Error achieving sync

Not lit No power / fault

Error LED color and indication

Color Indicates

Green, flashing Identify function activated

Not lit Identify function not activated (normal state)

LED Status Indicates

Link/Act LED Lit, solid Valid link detected

Lit, flashing Network traffic present

Not lit No valid link detected

Gigabit Lit, solid Gigabit connection detected

Not lit No Gigabit connection detected
 DNT-192 Dante Option Card Hardware Overview 5



PRIMARY Dante Port Ethercon connector with integrated LEDs for connecting to other Dante network devices.

SECONDARY Dante Port  Ethercon connector with integrated LEDs for connecting to other Dante network devices. 

Redundant and Daisy Chain LEDs

The SECONDARY Dante Port can be configured to create a redundant network, or to daisy chain to other Dante devices. Status 
is indicated by solid (not flashing) illumination of the Redundant and Daisy Chain LEDs. 

DNT-192 Option Card Back Panel
The back of the DNT-192 Dante Option Card features two ribbon connectors with latches. These receive Stage 64 ribbon cables 
for each bank of DNT channels (whether input or output). 

The back also has two threaded holes that align with the Stage 64 thumbscrews, to secure the back of the card to the interior of the 
Stage 64. 

LED Color Indicates

Link/Act LED Lit, solid Valid link detected

Lit, flashing Network traffic present

Not lit No valid link detected

Gigabit Lit, solid Gigabit connection detected

Not lit No Gigabit connection detected

LED Color Indicates

Link/Act LED Lit, solid Valid link detected

Lit, flashing Network traffic present

Not lit No valid link detected

Gigabit Lit, solid Gigabit connection detected

Not lit No Gigabit connection detected
DNT-192 Dante Option Card6



Installing and Confirming DNT-192 Dante Option Cards

This section shows how to install a DNT-192 Dante Option Card in the Stage 64 I/O rack and confirm installation. For operational 
information, see the VENUE | S6L System Guide.

Installing DNT-192 Option Cards in the Stage 64
The following instructions provide installation instructions that show a single DNT-192 Dante Option Card being installed as an 
input card in a Stage 64. Differences for input or mixed input and output installation are noted where relevant. 

To install a DNT-192 card in a Stage 64 IO Rack:

1 Shut down your VENUE system and power down your Stage 64. 

2 Disconnect all cables from your Stage 64. 

3 Remove the back panel of your Stage 64 by loosening the eight captive thumbscrews completely, using a #2 Philips screwdriver 
if necessary, and set the panel aside.

Figure 1. Stage 64 back panel captive thumbscrews

AC~100-240V;60-50HZ;2.0AAC~100-240V;60-50HZ;2.0A

DO NOT OBSTRUCT FANS
SERIAL NUMBER
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4 On the front of the Stage 64, locate the slots where you want to install the card. 
Each slot is lettered and corresponds to the card slot shown along the top of the VENUE Patchbay patching grid, depending on 
the type of card installed (input or output card). DNT-192 cards can function as input or output cards, or as both an input and out-
put card depending on which slots are used. Observe the following slot requirements when installing DNT-192 cards in Stage 64:

Input Only (16 channels per DNT-192) Are installed in pairs of slots A–H (A+B, B+C, C+D, D+E, E+F, F+G, G+H). 

Output Only (16 channels per DNT-192) Are installed in pairs of slots J–M (J+K, K+L, L+M). 

Input and Output (8 in/8 out) Must be installed in slots H+J. 

5 Remove the blank card slot covers by unscrewing the two Philips head screws that secure the slot covers to the Stage 64. 

If your Stage 64 already has cards in the desired slots, do the following to remove them: 
• From the front of the Stage 64, remove the thumbscrews securing each card to be removed. 
• From the back of the Stage 64, disconnect the ribbon cable connected to each card being removed by pushing the pair of 

latches outward (away from the connector) and then disconnecting the ribbon cable (see Figure 8). 
• From the back of the Stage 64, remove the captive thumbscrew(s) securing each card to the Stage 64 (see Figure 7). 
• From the front of the Stage 64, gently slide the card(s) out. 

Figure 2. Blank Input slot covers on the front of the Stage 64
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6 Remove the DNT-192 Dante Option Card from its packing material and hold the card by its edges, making sure the latches on 
the port on the back of the card are pushed inward.

7 Make sure all four of the Port latches on the card are positioned fully inward (towards each other). Doing so makes sure the 
latches don’t catch on anything when the card is installed into the Stage 64. 

Figure 3. DNT-192 Dante Option Card showing brackets and connector 

Ribbon cable ports

Mounting guide pin

Threaded Mounting holes (x2)

Port latches
 Installing and Confirming DNT-192 Dante Option Cards 9



8 Gently slide the card into the slots (Figure 4), making sure the Port latches don’t catch on anything. Also, make sure that inside 
the Stage 64 the pins at the top of the back of the card align with the corresponding guide holes on the chassis (Figure 5). 

Figure 4. Sliding the card into the Stage 64 

Figure 5. Guide pins and guide holes inside the Stage 64
DNT-192 Dante Option Card10



9 Push the card into the slot so it is flush with the front panel, and tighten the four captive thumbscrews on the front of the card 
to secure it to the Stage 64.

10 Inside the back of the Stage 64, tighten the two captive thumbscrews to secure the card to the chassis. 
Make sure the thumbscrews align with the threaded mounting holes on the back of the DNT-192 card. 

11 On the card, push the ribbon cable latches outward.

If the card does not slide all the way into the slot, make sure the latches on the ports of the card are pushed fully inward.

Figure 6. Tightening one of the four front captive thumbscrews

Figure 7. Securing a card to the Stage 64 chassis
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12 Locate the two corresponding Stage 64 ribbon cables (all ribbon cables in the Stage 64 are cut to length), and push the cable con-
nectors into the corresponding ports on the card so that the latches on the ports move inward and lock the connectors to the ports 
on the card. Double-check to make sure the card is connected securely. 

13 After all cards have been installed, replace the back panel, making sure to properly align the guide pins on the back panel to the 
guide holes, and secure it to the Stage 64 by tightening the captive thumbscrews.

14 Proceed to “Confirming Installation” on page 13.

Figure 8. Connecting ribbon cable (your installation may appear differently depending on the slots used for the DNT-192 card)

Figure 9. Back panel guide pins
DNT-192 Dante Option Card12



Confirming Installation
After you have installed any card, you should confirm that you have installed it properly.

To complete and confirm installation:

1 Connect the power cables to the Stage 64 and to a power source.

2 Connect the Stage 64 to the rest of your S6L system as described in the current version of the What’s New in VENUE guide. 

3 Power on your Stage 64 and the rest of the components of your S6L system.

4 In the VENUE software screen, go to the Options > Devices page.

5 In the Available Devices or Connected Devices columns, tap the icon of the Stage 64 in which you installed the I/O card so it is 
highlighted in blue.

6 Under Information, tap Settings. The I/O card slots of the selected Stage 64 are listed, showing the cards that are currently in-
stalled. Slots without cards are indicated as none. 
The newly installed Stage 64 I/O card should appear in the slot in which you installed the card. DNT-192 cards occupy two slots 
per card. 

For instructions on using the Stage 64, see the VENUE | S6L System Guide, included with the S6L system software in your Avid 
account.
 Installing and Confirming DNT-192 Dante Option Cards 13
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Compliance Information

Environmental Compliance

Disposal of Waste Equipment by Users in the European Union

This symbol on the product or its packaging indicates that this product must not be disposed of with other waste. Instead, it is your responsibility to dispose of your waste 
equipment by handing it over to a designated collection point for the recycling of waste electrical and electronic equipment. The separate collection and recycling of your waste 
equipment at the time of disposal will help conserve natural resources and ensure that it is recycled in a manner that protects human health and the environment. For more 
information about where you can drop off your waste equipment for recycling, please contact your local city recycling office or the dealer from whom you purchased the 
product.

Proposition 65 Warning

Perchlorate Notice
This product may contain a lithium coin battery. The State of California requires the following disclosure statement: 
“Perchlorate Material – special handling may apply, See www.dtsc.ca.gov/hazardouswaste/perchlorate.”

Recycling Notice

EMC (Electromagnetic Compliance)
This model complies with the following standards regulating interference and EMC:
• FCC Part 15 Class B
• EN 55022 Class B
• EN 55024 Class B
• AS/NZS CISPR 22 Class B
• CISPR 22 Class B

This product contains chemicals, including 
lead, known to the State of California to 
cause cancer and birth defects or other re-
productive harm. Wash hands after handling.
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FCC Compliance for United States

Radio and Television Interference

Australian Compliance

Canadian Compliance
This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.

Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le matériel brouilleur du Canada.

CE Compliance
(EMC, Safety, and ROHS)

Avid is authorized to apply the CE (Conformite Europenne) mark on this compliant equipment thereby declaring conformity to EMC Directive 2004/108/EC, Low Voltage 
Directive 2006/95/EC and RoHS Directive 2011/65/EC.. 

Korean EMC Compliance

Communication Statement
NOTE: This equipment has been tested and found to comply with the 
limits for a Class B digital device, pursuant to Part 15 of the FCC 
Rules. These limits are designed to provide reasonable protection 
against harmful interference in a residential installation. This 
equipment generates, uses, and can radiate radio frequency energy 
and, if not installed and used in accordance with the instructions, may 
cause harmful interference to radio communications. However, there 
is no guarantee that interference will not occur in a particular 
installation.  If this equipment does cause harmful interference to radio 
or television reception, which can be determined by turning the 
equipment off and on, the user is encouraged to try and correct the 
interference by one or more of the following measures:
• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from 

that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.
Any modifications to the unit, unless expressly approved by Avid, 
could void the user's authority to operate the equipment.
DNT-192 Dante Option Card16





Avid
280 N Bernardo Avenue
Mountain View, CA 94043 USA
Technical Support (USA)
Visit the Online Support Center 
at www.avid.com/support
Product Information
For company and product information, 
visit us on the web at www.avid.com
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